What's New in Autodesk Inventor 2017

Inventor 2017 is built for the expanding role of the professional engineer.

Design Enhancements: Design faster and optimize performance from the outset
Improved interoperability: Quickly bring design data together so you can build a complete definition of your product.
Integrated communication capabilities: Connect with anyone on the project team and share progress.

Together these enhancements help you create better designs, coordinate product development efforts across your team, and get your job done faster.

Design Enhancements

Sketch

New 3D sketch commands provide greater control, speed, and ease of use.

- A new 3D Transform command provides a rich set of geometry manipulation tools for moving and rotating geometry quickly and precisely.
- New constraint types are added to provide greater control and allow you to sketch curves on 3D faces.
- Copy/Paste supports copying and pasting in the same 3D sketch or between 3D sketches, reusing 3D sketch information for faster model creation.
Surfacing

Several new tools provide greater control when building surface geometry in Inventor 2017.

Guide Rails are added to the Boundary Patch command. You can now use curves and points to shape the patch and more precisely control continuity and form.

![Guide Rails](image)

Ruled Surface has a new Angle option for all surface types. The Sweep option is renamed Vector, and supports both edge and sketch selections to set the direction.

Part Creation

A new Feature Relationships tool identifies parent and child relationships between part features. This helps you quickly understand how parameters define the model, and can be used to execute or automate geometry changes.

![Feature Relationships](image)

Multiple patterning enhancements have also been implemented to help you model parts faster.

The Sketch Driven Pattern command quickly generates features or bodies in complex arrangements defined in a 2D or 3D sketch.
iFeatures support patterning and mirroring on multibody parts.

Circular patterns provide a new option for a fixed orientation to streamline modeling of circular arrays.

**Assembly Definition (not available in Inventor LT)**

Enhanced reporting of cross-part references within assemblies helps you more easily identify and access related parts.
Similar to sketch-driven patterns for parts, sketch-driven patterning for assemblies enables you to position parts in complex arrays defined by a sketch.

Mesh data can now be brought into Inventor and managed similar to other 3D CAD data. Interference detection now also identifies clashes between mesh parts and other geometry.
**Drawings**

Several new options enhance Drawings capabilities and give you more control over formatting. New options include:

- Jagged cut edges in section views
- Rectangular balloon style
- Default link setting in options dialog box
- Automatic text wrapping and other formatting enhancements
- Background text color options
- Ability to directly open a part from drawing parts list

**Shape Generator (not available in Inventor LT)**

Shape Generator, introduced in Inventor 2016 R2, helps with the conceptual design of structurally efficient parts. For Inventor 2017, several enhancements were made to the Shape Generator workflow and new controls were added.

Glyphs provide feedback on the location of Fixed, Pinned, and Frictionless constraints. These glyphs also now appear in the Stress and Modal Analysis environments in Inventor Professional.

- Interactive controls are provided for preserved region sizing and positioning
- New minimum member size criteria influences the size of features in Shape Generator outputs
- Users may directly assign the target mass rather than use a percentage reduction
- A new optional symmetry constraint causes outputs to be symmetrical about one or more planes

**Preserve Region**

![Image of Preserve Region window and 3D model]
Minimum Member Size

Symmetry

Sheet Metal

New workflow options and controls were added to the sheet metal environment in Inventor 2017:

- Expanded defer options
- Improved flat pattern warnings
- Ability to individually control punch reps
- New corner relief options
Tube & Pipe (not available in Inventor LT)

Several efficiency enhancements were made in the Tube and Pipe commands including:

- Find in Browser command is enabled within routes.
- There is support for Multiple Intermediate Point Creation on flexible hoses with fittings.
- A new Show Violations dialog box provides visual feedback for flexible hose violations.
- The Tube and Pipe Authoring and Tube and Pipe Styles dialog boxes are resizable.
- The destination folder in the Location for Run File field automatically updates when you change the name in the Tube and Pipe Run Name field and Run File Name field.

Guided Tutorials (not available in Inventor LT)

The Guided Tutorials have been enhanced for greater visibility and usability. The Videos and Tutorials pane is removed. Click Tutorials in My Home to view the new gallery. The gallery contains a live display of all tutorials currently available for download, and all installed tutorials. In addition, progress tracking is displayed in the gallery image and the active tutorial.
User Interface

Graphics adjustments compensate for the Gamma (luminance) and Linearization (data transfer relative to perceived brightness) used to display the graphics scene. These changes yield a more equalized cross-product viewing experience.

Environment and Standard Lighting styles used for model scene lighting are separated into Style types for an improved style management experience. The new tabbed interface complements the lighting style workflow and ensures compatibility with legacy styles. Shadow settings are managed individually with the lighting style.

Inventor 2017 supports high-resolution 4K monitors. Icons and dialog boxes throughout the application take advantage of the larger screens at 4K resolution.

Several new shortcuts speed up common tasks and allow you to customize Inventor for your specific workflow. You can configure shortcuts for visibility, transparency, routed systems commands, and more, in addition to prior commands. A transparency toggle switch enables quick investigation of the interior of assemblies.
Interoperability Improvements

AnyCAD Reference Model and DWG Underlay Technology (not available in Inventor LT)

Inventor 2016 introduced a method of associatively linking nonnative geometry to your Inventor model using a technology called AnyCAD. In Inventor 2017, significant enhancements were made to the Reference Model update behavior for CATIA, Solidworks, NX, and Pro-E/Creo files. Increased support for multithreading in import workflows results in increased performance and faster updates for reference model workflows. As well, Reference Model also supports STEP neutral file format. A STEP model can be referenced into an Inventor assembly. When the STEP file is updated, Inventor accounts for the design change in a manner similar to other 3D formats.

![Image of Import Options](image1)

DWG Underlay workflows are streamlined with new cropping and profile selection tools for greater productivity. DWG information can also be included in drawings as a reference.

![Image of DWG Sample](image2)

Mesh Handling

Mesh data can be brought into Inventor and managed, in the same way as other 3D CAD data. Measure and section tools can be used on mesh faces. Mesh can be selected and projected into sketches. The Fit Mesh Face command optionally allows users to convert a mesh face to a native Inventor surface, enabling the geometry to be edited downstream.

![Image of Mesh Handling](image3)
Communication Capabilities

Design Shares with Inventor Connected Design on Autodesk A360 (not available in Inventor LT)

A Design Share capability was added in Inventor 2016 R3 to facilitate design reviews with your team and other project collaborators anywhere, on any device. Several enhancements in Inventor 2017 make it faster and easier to collaborate. Collaborators and feedback can now be reviewed and managed directly inside Inventor. New controls permit you to share part properties and part names in addition to the model graphics for more detailed reviews.
Presentation Enhancements (not available in Inventor LT)

The presentations environment is enhanced to make your documentation creation tasks easier and faster.

- You can easily arrange components in exploded views for drawing creation and quickly create powerful and expressive animations.
- Snapshot views allow you to capture specific model and camera arrangements for use in drawing views and raster image outputs.
- A new timeline-based story panel makes it easy to control and edit assembly sequences or movement. You can change the duration or order of actions appearing in an animation.

3D PDF Publishing (not available in 32-bit Inventor LT)

Inventor 2017 can export your models in 3D PDF format, which can be viewed in Adobe Acrobat Reader. Select design view representations, model properties, and attachments to include. Use Adobe Acrobat Reader to open 3D PDF files. Create a custom 3D PDF template to change arrangement of exported elements in the output files.
Part Design Enhancements

Enhancement to Circular Pattern Allowing Identical Occurrences

Select Fixed to preserve the orientation of the body or source feature set. You can also redefine the base point for your body or feature set. The default uses the intersected profile center for the base point.

Sketch Driven Pattern

The Sketch Driven Pattern command is introduced. You can now pattern features or bodies on sketch points defined in a 2D or 3D sketch. Optionally, you can redefine the Base Point or pick Faces to orient the pattern.
**Boundary Patch**

The Guide Rails option is added to the Boundary Patch command. You can now select curves and points to shape the patch.

![Boundary Patch Diagram](image)

**Ruled Surface**

- The Angle option is added to all ruled surface types.
- The Sweep surface type is renamed Vector and now supports both edge and sketch selection.
- Alternate All Faces and Automatic Edge Chain is added to the Vector surface type.

![Ruled Surface Diagram](image)

**Window Cross Select Multiple Closed Profiles Within the Extrude Command**

You can now use a window to select multiple closed profiles when you use the Extrude command. Previously, you had to select closed profiles one at a time.

![Extrude Window Selection](image)
View the Parent/Child Relationship Feature from Within a Part

In the Part environment, you can now easily access the parent/child-feature relationships from a part through the model browser or graphics window. This new interactive dialog box allows you to view feature dependencies from directly within your part. In the Relationships dialog box, select the icon to switch to a Selected view. Select the icon to access the Edit Feature dialog box.

The parent/child feature dependencies are viewable in the Relationships dialog box. These features include:
- Sketches
- Shared sketches
- Axes
- Planes
- Points

To access the Relationships dialog box and viewable feature dependencies:

**Model browser:** Right click the feature node in the model browser to display the context menu and select Relationships...
**Graphics window:** Set the selection filter to Select Features, select a feature in the display, right-click, and select Relationships...

---

**Part File Template**

View representations in the part file template are enhanced to make it simple to document your design.

The part file template now contains the following view representations:

- Master (locked)
- Isometric (default)
- Front
- Top
- Right

**Tip:** Make sure that you activate the correct View representation before you change the default Home, Top, or Front assignments.
Sheet Metal Enhancements

Punch Representation Visibility

New options let you control the individual punch representation display.

The following Flat Pattern Overrides are added to the PunchTool dialog:
- Show Formed Punch Feature
- Show Sketch Representation
  Note: The Sheet Metal Punch iFeature must be defined with a simplified sketch representation in order to use this option.
- Show Center Mark

Ignore Flat Pattern Overrides is added as an option to the Punch Representation tab of the Flat Pattern edit dialog.

A punch tool whose shape extends beyond the boundary of the flat pattern can now have its definition overridden to display as a center mark or sketch without error.

A legacy flat pattern punch override continues to display an error until the flat pattern is deleted and recreated in Inventor 2017.

Corner Relief

The options Round (Tangent), Round (Vertex), and Square (Vertex) are added to corner reliefs to provide more placement solutions.
Flat Pattern Compute Errors

A flat pattern that has compute errors displays an information icon in the browser and participates in the Design Doctor.

Unfold iFeatures

The option Unfold in Flat Pattern is added to the Extract iFeature create dialog and to the PunchTool insert dialog. This new option lets you unfold certain types of punch features. You must specify the unfold option in both places to unfold the punch shape.
- Unfolding is limited to iFeatures that can be unfolded if they were created as normal sheet metal features.
- Deformed shapes, such as stamped bosses and louvers, cannot be unfolded.

Enhancements to Sheet Metal Dialog Boxes

The following dialog boxes contain new features:
- An Apply button is added to the Corner Round and Corner Chamfer dialog boxes to improve efficiency.
- The Corner Round dialog box is now resizable and persists throughout your session.

Defer Flat Pattern Update

- The Flat Pattern Compute option is added to the Modeling tab of the Document Settings dialog box.
- Defer Update on Flat Pattern is added to the File Open Options.
You can also right-click the Flat Pattern on the browser to defer the update.

**Direct Edit**

The Direct Edit command is added to the Sheet Metal Modify ribbon panel.
3D Sketch Enhancements

General 3D Sketch

Context menu

The following commands are added to the context menu when you draw geometry:

- Align to Plane
- Orient Z
- Orient to World
- Snap Intersection

Status bar

The following controls are added to the status bar:

- Ortho Mode
- Dynamic Dimension
- Snap Object
- Infer Constraints

Copy/Paste

Copy and Paste functionality is added to the 3D sketch environment. You can copy and paste entities in the same 3D sketch or between 3D sketches.

Tip: The geometry is pasted in the same location as the source geometry. You can move the geometry after you paste it.

Drag geometry

Previous releases supported dragging geometry by endpoints and center points only. You can now drag a 3D sketch entity by selecting any part of the geometry.
Constraints

The following constraint types are added to the Constrain command:

- **On Face**: Constrains selected points, lines, arcs, or splines to a planar face or selected points to a curved face.
- **Equal**: Constrains selected arcs and lines to the same length.
- **Parallel with X Axis, Parallel with Y Axis, Parallel with Z Axis**: Causes selected linear geometry to lie parallel with the X, Y, or Z axis.
- **Parallel with XY Plane, Parallel with YZ Plane, Parallel with XZ Plane**: Causes selected geometry to lie parallel with the XY, YZ, or XZ plane.

**Delete Constraints** is added to the context menu.

**Draw Curves Directly on a Face**

**Curve on Face**: You can create an interpolation 3D spline on a part face by directly sketching it in place. Curve creation supports snapping to vertices and edges, constraints, point insertion and editing, curvature display, and so on.
3D Sketch Draw Tools

A new 3D space indicator and added functionality is introduced to the 3D Sketch environment.

- **Ortho Mode**: Use Ctrl+R, the context menu, or the icon in the tray to toggle Ortho Mode on and draw along an X, Y, or Z axis.
- **Dynamic Dimension**: Use Ctrl+D, the context menu, or the icon in the tray to toggle the dynamic dimension display on or off.
- **Draw on plane**: Click a plane on the space indicator to draw on a plane.
  Tip: Press Shift+Space to toggle between the planes and parallel with the screen.

3D Transform

The 3D Transform command is added to the 3D Sketch environment, Modify panel. The new 3D Transform command provides a robust set of geometry manipulation tools.

Use the new command to freely or precisely move or rotate the geometry. You can also set options to reorient the triad or manipulate the geometry based on the World, the current View, or the Local coordinate system.
Assembly Enhancements

Make Components Transparent

You can now toggle the transparency of a component in an assembly without applying an Appearance override.

Select one or more components in the graphics window or browser and then:

- Right-click and select Transparent from the context menu.
- Select iProperties from the context menu to open the dialog box. Click the Occurrence tab, and then select the Transparent check box.
Cross-Part Reference Enhancements

The assembly browser now contains additional controls and relationship details for components with cross-part dependencies.

The browser nodes now display the following information:
- Dependent source component names now display in the reference browser node.

The source dependency is illustrated by the following icons:
- Edge
- Face (outer and inner boundaries of face are projected)
- Loop
- Sketch geometry
- DWG geometry

Cross-Part Reference - Occurrence Path displays a useful tooltip when you mouse over the node.

Break Link is available from the browser node.
Open Files Directly from the Browser Node

A new right-click context menu option is available in the assembly browser Modeling View that lets you open reference files directly from your browser.

In a part file, right-click the Reference node in the browser and select Open Parent Assembly from the context menu to examine cross-part references in the assembly file the reference was created in. Select Open References to open the part the reference was created from.

In addition to References in a sketch, the same functionality is available for adaptive work features for copied objects.
Tube and Pipe Enhancements

Find in Browser Command Now Enabled within Routes
The Find in Browser context menu option is now enabled during route creation and also when placing flexible hose fittings.

Support for Multiple Intermediate Point Creation on Flexible Hoses with Fittings
Two new context menu options, Offset Point, and Intermediate Point, allow you to create multiple intermediate points when you route a flexible hose with fittings. You can place one fitting, construct the hose, and finish by placing the second fitting. You can also place both fittings and construct the hose switching between Intermediate Point and Offset Point commands.

New Show Violations Dialog Box Provides Visual Feedback for Flexible Hose Violations
The message box that displays when you check a problematic bend radius has been replaced with the new Show Violations dialog box. The new Show Violations dialog box displays a tree view of spline segments where bend radius violations occur. Selecting a node in the dialog box highlights the corresponding segment in the graphics window.

Enhancements to Tube and Pipe Dialog Boxes

- **Tube and Pipe Styles**: Resizing the dialog box now also increases the size of the Style Settings Panel. Scrolling is no longer required to read the entire Name, Family, Standard, or Appearance information.
- **Tube and Pipe Authoring**: Now resizable, the width of the dialog box also increases when over seven connection numbers are added.
- **Tube and Pipe Runs File Name**: The destination folder in the Location for Run File field automatically updates when you change the name Tube and Pipe Runs File Name field and Run File Name field.
Tube and Pipe End Treatment Publishing Enhancement

While publishing Tube and Pipe content in the Tube and Pipe Authoring dialog box, the last used End Treatment setting for connections auto populates when you add connections.

Additional Productivity Enhancements

- The context menu option, Change Fitting Diameter, available for fittings in rigid routes starting in Inventor 2016, is now available for fittings in a flexible hose run. You can select one or more fittings in a flexible hose run and change the diameter for all selected fittings.

- New context menu options, Change Size and Edit Connection are available when placing a fitting into an existing route.
- New context menu option, Delete All Connections, is available when you select multiple Tube and Pipe components.
- Use the spacebar to flip fitting connections on a Tube and Pipe fitting within a run that does not contain any routes.
- You no longer need to click the OK button in the Connect Fitting dialog box to accept a Free Fitting and a Base Fitting selection. The default focus in the Connect Fitting dialog box is now set to OK.

- In an active route, you can now multiselect and delete a selection of multiple work features that were added as Included Geometry.
Presentations, Exploded Views, and Publishing Enhancements

Commands available in the reworked Presentations environment cover functionality available in previous versions and include several new features.

Migrate Presentations Created in Previous Versions

All information from your old presentation files is automatically migrated to a new version.

Exploded views are converted to snapshot views. All tweaks and other model and camera settings are preserved.

Animations (Task Sequences) are converted to storyboards. Tasks are converted to animation actions and added to the timeline.

Create a Presentation

You can create a presentation file based on a default or custom template. You specify the model on file creation, or you can insert the model to an existing IPN file.

A presentation file includes scenes. Each scene is based on a specific source model and set of model representations. A scene stores snapshot views and animation storyboards.

Tweak Components

Use the Tweak Components command to move or rotate components. Tweaks are saved as actions to the animation timeline, and listed in the Tweak folder in the browser.

Add Trail Lines for Tweaked Components

To create trail lines, on the Tweak Components minitoolbar, select a trail option from the list. All Components is selected by default.

To hide a trail, right-click a trail line, and click Hide Trail Segment Current or All. Or, in the browser, Tweak folder, right-click a component, and click Hide Trails.

Set Component Visibility and Opacity

To set component visibility, select the component, right-click, and click Visibility.

To set opacity for a component, select the component, and then on the ribbon, click Presentation tab >Transform panel Opacity.

You can change the visibility and opacity setting in a snapshot view, or save the change as an action to the storyboard. To create an action, move the playhead to the desired position on the storyboard timeline first. To change the initial setting for a storyboard, move the playhead to the Scratch Zone.
Create Snapshot Views
A snapshot view stores a specific model arrangement. Snapshot views can be linked to the timeline or independent.

Snapshot views are used to create drawing views or raster images of a model.

Create Animations
An animation consists of a sequence of actions positioned on the timeline. You can create the following types of actions: Move component, rotate component, change component visibility or opacity, and change camera position.

Animations can be published as videos.

Change Position of Camera
Use commands on the Navigation toolbar to change the view of the model. The camera setting is not saved automatically.

To change camera position in a snapshot view, edit the snapshot view, and click Update Camera.
To save a camera position to an animation, place the playhead to the desired position on the timeline, and click Capture Camera. A camera action is added to the timeline.

Publish a Presentation
You can publish to a video file (AVI and WMV) or to a raster image (BMP, GIF, JPEG, PNG, and TIFF).

You set the publishing scope and other output options.
DRAWINGS

Drawing Enhancements

Jagged Cut Edges in Section Views

You can select the type of break lines for partially sectioned components in section and detail views. Smooth and Jagged options are available in the Section View dialog box, Edit Section Properties dialog box, and the Style and Standard Editor dialog box.

By default, cut edges are displayed as smooth lines.

To change the Default Cut Edges setting to jagged lines:

- In the Style and Standard Editor, select the Active Standard.
- On the View Preferences tab, select Section or Detail as the View Type.
- Under Default Cut Edges, select Jagged.

To override the setting for a specific section view, select Jagged in the Section View dialog box, or in the Edit Section Properties dialog box.
Rectangular Balloon Style

A rectangular balloon style option is now available, supporting multiple selected properties to display. Access the new balloon option from the following dialog boxes:

- Style and Standard Editor (Balloon)
- Edit Balloon
- Auto Balloon

Default Link Setting Added in Application Options Dialog Box

In the Application Options dialog box Sketch tab, select or deselect the Enable Link option by default during image insertion check box to customize the default setting when inserting an image from the Sketch menu.

Automatic Text Wrapping in Title and Column Headings in Drawing Tables

The General, Part Lists, Hole, or Revision tables in drawings, columns, and headings now support automatic text wrapping. Column headings wrap to a minimum width to accommodate the largest word in the column. Table headings wrap to the minimum width of the included columns.

Tip: Legacy drawings, when first opened, continue with the legacy behavior. To change a table to include the new functionality, open the Edit Table dialog box and click OK to allow for text wrapping.
New Adjust QTY Setting in Parts List Filter for Design Views

A new Adjust QTY option is added to the Design View Filter for a Parts List in a drawing. This new feature controls the default behavior of the LINK checkbox in the Insert Image dialog box. The Adjust QTY option is accessible through the Filter Settings dialog box.

When the Adjust QTY checkbox is enabled, the option quantity in a parts list adjusts according to the visibility of the items in the design view. Only these visible parts are taken into account for QTY and ITEM QTY columns in a parts list.
**INTEROPERABILITY**

**DWG Underlay Enhancements**

**Support for Associative DWG Underlay in Drawings**

These enhancements to associative DWG underlay streamline data re-use, translation, management, and the design change update processes.

You can now include DWG underlays in drawings and do the following:

- Add text and dimensions to annotate the DWG underlay geometry.
- Easily manage layer styles and line types. The AutoCAD layer styles and line types are imported into the drawing file. Use the Styles Editor to manage the layers and line types as needed.

Changes made to the DWG underlay geometry in the corresponding Inventor file associatively update in the drawing file. To associatively update changes made in the AutoCAD file in the drawing file, you must first update the DWG underlay in the part file. Include a DWG underlay in a drawing view that also has model geometry, you must right-click in the DWG underlay in the browser and select **Include**.

**New Crop Workflow for DWG Underlays in Parts**

You can now crop the DWG underlay to improve performance and remove unwanted data in part files.

- Cropping allows you to focus on the relevant design area when you are working with a large DWG file.
- Underlay geometry cropped in a part file displays as cropped geometry in a drawing view of the part file.
- Add constraints and joints to cropped underlays in an assembly file.

**Support for Associative Placement**

The location of a DWG underlay now associatively updates when the location of the DWG underlay’s plane and/or insertion point changes. For example, if you place a DWG underlay on the corner of a model, and then change the location of the corner of the model, the location of the DWG underlay updates associatively. The changes you make with the Translate command are now also associative.

**Important**: To make underlay placement associative, you must select one of the following points as the insertion point when placing a DWG underlay:

- 2d Sketch point, start/center/end point of 2d sketch curves
- Start/center/end point of edges
- Center point of face
- Work point
- Vertex
Support for changing and re-establishing the associative plane and origin point

Use the new **Redefine** browser context menu option to:

- Move the DWG underlay to a different associative plane and origin point.
- Reconnect the DWG underlay's plane/point of associativity if the dependent plane and origin point are deleted.
- Re-establish associativity with legacy files: The associativity that exists in a DWG Underlay Inventor 2016 part or assembly file is not maintained when you open the file in Inventor 2017. Use the Redefine command to re-establish the associativity.

Reinsert a DWG with Ease

You can now easily reinsert the same DWG file into the part file: Right-click the DWG node in the browser, and select the new context menu option, **Add Instance**.
Updating Files from Other CAD Systems Enhancements

Reference Model Translation Improvements

- Significant improvements were made to the Reference Model update behavior for CATIA, Solidworks, NX, and Pro-E/Creo files. References now have a robust level of associativity.
- Inventor 2016 enabled support for multithreading. (Multithreading allows Inventor to use multiple processors if the hardware you are using uses a multi-core processor.) As a result, performance is increased when working on files from other CAD systems. Inventor 2017 provides more support for multithreading in import workflows, which results in increased performance and faster updates.

Import STEP as a Reference Model

You can now import STEP as a Reference Model. Importing a STEP file as Reference Model maintains a link to the selected file which enables you to monitor and update as the model changes. Import a STEP file as a Reference Model when you expect only minimal updates to the STEP file.

Support for Property Overrides in CAD Files Imported as a Reference Model

You can now specify property overrides for CATIA, Solidworks, NX, and Pro-E/Creo files when the file is imported as a reference file using the Assemble ComponentPlace Imported CAD Files command into an Assembly. Additional enhancements:

- Override values entered in the iProperties dialog box display as blue.
- Revert the value back to the original value using the new context menu option, Value From Source.
- Override values display in the Bill of Materials.
Mesh Component Enhancements

Create Faces, Add Work Features, Constraints, and More on Mesh Models

There are significant improvements in working with mesh models.

- **Import OBJ** format into Part or Assembly documents. Large mesh files may import slowly.
- **Export** Solid/Surface/Mesh models to OBJ format. Color is not currently supported.
- Create faces from mesh facets using the **Fit Mesh Face** command. Select a mesh facet and the face type you want created, or accept the Auto Fit option, and a preview of the surface appears. Click Apply and the face is created.
- Use the **Constrain** and **Assemble** commands to create relationships between meshes and between mesh and solids or surfaces.
- Add **work features** using mesh as input for workplanes, axes, and points. There are two input exceptions: Center Point of Torus and Loop of Edges.
- Use the **Measure Distance** and **Angle** commands with assorted mesh inputs: faces, edges, vertices, and inferred mesh axes, center points, and middle points. Measure Distance and Angle between a mesh component and an assembly feature is not currently supported.
- **Load Express** is supported. Import a STEP or JT assembly mesh and save the Inventor assembly and use express mode.
- **Visual Styles** are supported for mesh components.
Translators Enhancements

New 2017 Translators and Supported File Versions

<table>
<thead>
<tr>
<th>Translator</th>
<th>Import</th>
<th>Export</th>
</tr>
</thead>
<tbody>
<tr>
<td>CATIA V5</td>
<td>R6 - V5-6R2015</td>
<td>R10 - V5-6R2015</td>
</tr>
<tr>
<td>NX</td>
<td>Unigraphics V13 - NX 10</td>
<td></td>
</tr>
<tr>
<td>Parasolid</td>
<td>Up to 28.0</td>
<td>9.0 - 28.0</td>
</tr>
<tr>
<td>SolidWorks</td>
<td>2001 Plus - 2016</td>
<td></td>
</tr>
<tr>
<td>IFC</td>
<td></td>
<td>IFC 2x3 format</td>
</tr>
<tr>
<td>OBJ</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

New Supported Reference Model Format

You can now import STEP as a Reference Model. Importing a STEP file as Reference Model maintains a link to the selected file which enables you to monitor and update as the model changes.
3D PDF Export Enhancements

You can export your models in a new format: 3D PDF. In addition to PDF format, a 3D PDF file includes 3D views of the model. When you export an Inventor model, selected design view representations are converted to model views and placed in the 3D PDF file.

3D PDF files are viewed in Adobe Acrobat Reader. Use 3D navigation tools to manipulate with the model views. Display the Model Tree to display model components and data included in the 3D PDF file.

A 3D PDF template file specifies arrangement of exported elements. You can create custom 3D PDF templates and use them to export your models.

Use Task Scheduler to export multiple models to 3D PDF files in a batch process.
Inventor Connected Design on A360 Enhancements

Significant improvements to the Connected Design on A360 workflow make it faster and easier to conduct 3D design reviews with your team and other project collaborators anywhere, on any device.

Tools for Managing Design Shares are Now Also Available in Inventor

The tools for managing Design Shares, previously only available on your A360 drive, are now also available in Inventor. They are located in the Connected Design on A360 panel on the new Design Shares tab. Design Share owners can now manage Design Shares directly inside of Inventor.

Quickly Move or Hide the Connected Design Entry Button

- You can now move the Connected Design entry button to a location on the graphics window that works best for you. You can also move the Connected Design entry button back to its default position using the new context menu on the Connected Design entry button.
- New context menu options on the Connected Design entry button also make it easy to turn off Design Shares and get Help with using Inventor Connect.
Design Share Comments Now Available Inside Inventor

Owners and collaborators who have Inventor 2017 can now open a Design Share, view, and post comments in the viewing window inside of Inventor.

Improved Assistance with Configuration Issues

Configuration issues are now reported in the Design Shares panel. You can press F1 to go to a topic that explains different configuration issues and provides steps for resolving.

The Connected Design entry button changes to a broken share icon to indicate an issue with configuration.
General Enhancements

iFeatures Now Modify Multiple Bodies

You can now modify multiple solid bodies in a single cut operation. For example, you can use a single iFeature to cut a hole through multiple bodies in one operation. Previously, when you placed an iFeature, you could choose which body in a multibody part would be affected by the iFeature, but were limited to one single affected body.

Guided Tutorials

In previous releases of Inventor, the Guided Tutorial gallery displayed installed tutorials in the Videos and Tutorials panel with a small thumbnail. Clicking the More button in the panel displayed a download page which listed available tutorials as text with no graphics.

In 2017, the Videos and Tutorials panel was removed. You now access Guided Tutorials by clicking Tutorials from the My Home panel. The display contains a gallery of all currently available tutorials.
Changes to 2017 Content Center Libraries (not available in Inventor LT)

The Content Center libraries are updated to the latest industry standards.

For complete details on the changes to the Content Center libraries, see [Updates to 2017 Content Center Libraries](#).

Improved Lighting Style Management

🌟 Environment (shown above) and💡 Standard Lighting styles used for **model scene lighting** have been separated into Style types for an improved style management experience. The two style types are distinguished visually by different icons and in the properties listed in the dialog box.
Shadow Settings Enhancements

Shadow Settings are managed individually within each Lighting Style. These settings are located on the Shadows tab within the Styles Editor user interface. A new option, Environment, uses the environment image to define Shadow Direction.

Inventor Keyboard Shortcut Options Added

The following enhancements were made to Inventor keyboard shortcuts:

F2 Key Shortcut Enhancement

You can now rename a node in your model browser by selecting the node and pressing F2

Customizable Keyboard Shortcuts

The following customizable keyboard shortcut options are now included in the Customize dialog box Keyboard tab:

<table>
<thead>
<tr>
<th>Keys</th>
<th>Command Name</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undefined</td>
<td>Change Fitting Diameter</td>
<td>Tube &amp; Pipe</td>
</tr>
<tr>
<td>Alt+C</td>
<td>Create Drawing View</td>
<td>Drawing Manager</td>
</tr>
<tr>
<td>Undefined</td>
<td>Edit Fitting Connections</td>
<td>Tube &amp; Pipe</td>
</tr>
<tr>
<td>Undefined</td>
<td>Edit Fitting Orientation</td>
<td>Tube &amp; Pipe</td>
</tr>
<tr>
<td>Ctrl+D</td>
<td>Open Drawing</td>
<td>Assembly</td>
</tr>
<tr>
<td>Ctrl+D</td>
<td>Open Drawing</td>
<td>Presentation</td>
</tr>
<tr>
<td>Undefined</td>
<td>Restore Fitting</td>
<td>Tube &amp; Pipe</td>
</tr>
<tr>
<td>Alt+A</td>
<td>Switch Browser Pane Backward</td>
<td>Tools</td>
</tr>
<tr>
<td>Alt+S</td>
<td>Switch Browser Pane Forward</td>
<td>Tools</td>
</tr>
<tr>
<td>Alt+T</td>
<td>Toggle Transparent State</td>
<td>Assembly</td>
</tr>
<tr>
<td>Alt+V</td>
<td>Visibility</td>
<td>Assembly</td>
</tr>
</tbody>
</table>
Shortcut to Toggle Inventor Browser Through Other Available Browser Panes

New **Switch Browser Pane Forward** and **Switch Browser Pane Backward** toggle commands are available as configurable keyboard shortcut commands through the Tools > Customize command. This enhancement allows you to cycle forward or backward through browser panes that are available in the Inventor model browser; for example: Favorites, Representations, and Vault.

Visual Conflict with Select Other Option Resolved

The Select Other feature drop-down menu no longer interferes with the visibility of the object selected.

Enhancements to Dialog Boxes

The following dialog boxes contain new features:

- **Interference Detected dialog box**: A new icon is added in the first column of the interference table in the Interference Detected dialog box. Click the icon to zoom to the exact location of the detected interference. Previously, you could zoom to the interference by double clicking the item in the dialog box. This action is still supported. The icon is added to make this feature more discoverable.

  You can sort any column in the lists available within the Interference Detected dialog box.
• **Customize dialog box:** In the Customize dialog box, on the Keyboard tab, an ascending/descending arrow is added to the columns for sorting. You can also select a column and press a key to search items in your selected column.

• **Parts List dialog box:** In the Parts List dialog box, you can select one or more entries, right click, and open the associated component file (not available in Inventor LT).

![Parts List dialog box](image)

• **Bill of Materials dialog box:** When accessing the Bill of Materials editor in a drawing file, select any cell to open the associated component file (not available in Inventor LT).

![Bill of Materials dialog box](image)

• **iProperties dialog box:** Sort custom iProperty values alphanumerically in the iProperties dialog box > Custom tab.

• **Resizable dialog boxes:** The following dialog boxes are now resizable and persist throughout your session:
  - Interference Detected dialog box
  - Insert iFeature dialog box
  - Paste Features dialog box
  - Custom tab in the iProperties dialog box
  - Custom dialog box (all tabs)
Export to PDF Options

When you modify the Print range variable, the setting is now remembered and persists throughout your sessions.

Enhancements to Task Scheduler

Set Defer Update on Flat Patterns is added to the Migrate Files and Update Design options to provide better control on sheet metal updates.

Shrinkwrap Assemblies

You can now batch publish shrinkwrapped versions of your assembly models in Task Scheduler with the same settings in the Assembly Shrinkwrap Options dialog box:

- All the settings in the Assembly Shrinkwrap Options dialog box now are also available in the Task Scheduler Shrinkwrap Options dialog box.
- The setting in Application Options > Part tab, Use color override from source component, is now available in the Task Scheduler Shrinkwrap Options dialog box.

Local Help Now Supports Multiple Languages on the Same Computer

You can download and install the offline help in multiple languages on the same computer and access the appropriate language depending on the active language pack. No reboot is required to access the local help in a different language.

To access the help in another language, switch to another language pack.

For more information, see
- Inventor 2017 Local Help
- Inventor LT 2017 Local Help

More Control for My Home

You can now specify the number of recent documents that display in the My Home environment. The default number is 50, and the maximum is 200. To access the setting: Tools > Options > Application Options - General tab.
Graphics Display Enhancements

Graphics scene adjustments have been made to compensate for luminance and brightness. These changes yield a more equalized cross-product viewing experience.

The changes mainly affect the modeling environment and have a relatively small effect on drawing shaded views where specific metallic materials have been used. The net effect may look like an increase in exposure or brightness, most noticeable when ray tracing is enabled. If needed, adjust the lighting exposure settings for styles used or created in previous releases.